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WARNING DEFINITIONS 

The warnings described in this manual have the following definitions: 

 

■Warning Definitions 

 
An imminently hazardous situation which, if not avoided, will result in 
death or serious injury. 

 
A potentially hazardous situation which, if not avoided, could result in 
death or serious injury. 

 

A potentially hazardous situation which, if not avoided, may result in 
minor or moderate injury. This warning may also be used as an alert 
against unsafe practices. 

 

■Symbol Examples 

 

The symbol  indicates “Caution”. 

The contents of the caution are described inside or near the symbol, 
using text or a picture. 

The example on the left indicates caution against electrical shock. 

 

The symbol  indicates “Do not.”  

The contents are described inside or near the symbol, using text or a 
picture. 

The example on the left indicates “Do not disassemble.” 

 

The symbol  indicates “Never fail to.” 

The contents are described inside or near the symbol, using text or a 
picture. 

The example on the left indicates “Never fail to perform what is 
described”. 

 

■Other 

NOTE Provides information useful for the user to operate the device. 

Precautions for each operation are described in the instruction manual. Read the 

instruction manual before using the device. 
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SOFTWARE LICENSE AGREEMENT  
Please be sure to read the conditions of this “Software License Agreement” described herein 

prior to using the A&D Software.   
 
This Software License Agreement was created by A&D Company, Limited and it applies to all 

Users that install the A&D Software. Users are only permitted to use the A&D Software upon 

agreeing to all of the conditions set forth below.  
 
Customers must agree and satisfy all of the conditions of this contract before installing, copying 

or using this software in another manner. 

A&D Company, Limited prohibits customers who disagree the terms of this Software License 

Agreement from installing or copying the A&D Software. Furthermore, A&D Company, Limited 

requires that you carefully read this Software License Agreement and fully understand your 

rights and obligations herein prior to using the A&D Software. 

 

Software License Agreement 

The software has been provided to the customer (“User”) by A&D Company, Limited (“A&D”) 

pursuant to the terms and conditions below.  
 
1. Definitions 

1.1. Software 

“Software” refers to the program in a machine-readable format that has been recorded as 

memory data on a master disk and included in this package, in addition to the instruction 

manual and other data that explain the procedure for using the “Software” 

1.2. Use 

“Use” refers to the reading of memory data from the Software. 

1.3. Designated Machine 

“Designated Machine” refers to one (1) computer set up for the purpose of using the 

Software. 

1.4. Copying 

“Copying” refers to the duplication or reproduction in a similar or different format of 

memory data contained in the Software. 

1.5. Alter 

“Alter” refers to all updates or modifications to the Software, or the use of the Software in 

part or in whole to create other derivative software. 
 
2. User Rights 

2.1. A&D permits the User to use the Software pursuant to conditions of this agreement. 

2.2. The User shall install and use the Software on only one (1) Designated Machine. 

2.3. All ownership rights for the Software shall be retained by A&D. 
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3. Copying the Software 

The User is strictly prohibited from copying the Software, unless the copies are made for the 

purpose of using the Software on the Designated Machine or the copies are made for the 

purpose of backup. 

 

4. Altering the Software 

The User may not alter, decompile, disassemble, decrypt, extract or otherwise 

reverse-engineer the Software or otherwise create any derivative works thereof. 

 

5. Intellectual Property Rights 

All copyrights and other intellectual property rights in the Software and any derivate thereof, 

irrespective of the reason, shall be retained by A&D or the person or legal entity described in 

the Software. The User shall not remove any annotations regarding copyrights or other rights 

from the Software or any duplicates thereof. 

 

6. Restrictions Regarding Sublicensing and Transfers 

The User shall not transfer possession of the Software or any derivatives thereof to a third 

party, nor shall the User transfer any user rights or sublicenses without the express consent of 

A&D. 

 

7. Copyrights and User Rights  

All copyrights and user rights regarding materials, such as image files and symbols, shall be 

in accordance with those contained in the Software.  

 

8. Warranties 

Only those warranties described below are applicable to the Software. Furthermore, A&D 

does not warrant that the Software is free of defects. 

8.1. A&D will exchange or replace the CD-ROM for the software or other print materials in the 

event that those materials contain defects.  

8.2. A&D will not be liable in the event that a defect in the underlying Software causes an 

accident, damage or loss, or for negligence, misuse or other injury caused by reasons 

not attributable to A&D.  

8.3. The User shall be responsible for the selection of the Software to achieve the User’s 

expected results, as well as for the installation, use and results arising out of the use of 

the Software. 

8.4. A&D shall not accept responsibility or provide warranty against defects in the Software.   

8.5. A&D shall not accept any responsibility for any direct, indirect or consequential damages 

caused by the User arising out of the use of the Software, or any loss related to data, 

programs or other intangible assets, as well as any profit that should be acquired or loss 

regarding the Software. 
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9. Miscellaneous 

9.1. A&D may upgrade the Software at any time, and the conditions for the distribution of the 

upgraded version will be decided by A&D. 

9.2. Unless the User is provided with prior notice, the conditions of this contract and the 

information contained in other related notices shall apply. Furthermore, unless there are 

changes in the documents mentioned herein, the terms of prior and existing contracts 

and notices shall be deemed ineffective, and only the conditions of the latest contract or 

related notices shall apply. 

 

10. Validation Period 

10.1. This Contract shall become effective upon the installation of the Software by the User 

and shall remain effective until the User terminates this contract in accordance with 10.2. 

or 10.3. below. 

10.2. This contract will terminate when the customer disposes of the Software, including 

backup copies, and deletes all data previously installed from the Software.  

10.3. This contract will terminate immediately in the event that the customer disagrees with 

any of the conditions set forth herein. 

10.4. The Customer must immediately dispose of the software in the event that this contract is 

terminated in accordance with conditions 10.3. above. 

10.5. Clauses 3 to 11 shall remain effective beyond the termination of this agreement. 

 

11. Obligations Extending Beyond Termination 

Upon the termination of this contract, the User is responsible for destroying the Software and 

deleting the memory data on the User’s Designated Machine to prevent the Software from 

being used by a third party. In addition, all duplicates and derivative materials relating to the 

Software must also be destroyed.    
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PRECAUTIONS FOR USE 

In order to use the device safely and correctly, please read the following precautions carefully 

before using the device. More precautions appear in the main text of the instruction manual. 

Read the manual thoroughly before using the device. After reading, store the manual in a readily 

available location for future reference. 

 

1. Storage site 
 

 

 

Avoid the followings as a storage site. 

 Areas where the temperature is less than -20°C or greater than +55°C, and 
the relative humidity is over 95% 

 Areas where chemicals are stored 

 Areas where exposed to direct sunlight 

 

 

2. Maintenance 

 

 

 

 Inspect cables before use and periodically. 

 When a cable is used after a long period of storage, confirm that the device 
is functioning correctly and safely. 

  Clean the cable with a dry, soft cloth. 
Do not use thinner, alcohol, benzine, or wet dusters. 
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3. Precautions against strong electromagnetic waves 

 

 

  If strong electromagnetic waves are present near a personal computer during 
communication, errors in data transmission or an unintended operation may 
occur. 
Under such conditions, check the electromagnetic status and take necessary 
measures. 

 
 

The following are general examples of factors that may interfere with the proper functioning of 

the device and recommended solutions. 

 

 Cellular phone use 

   May cause undesired operation because cell phones emit electromagnetic waves. 

  In a room or building where the device is used, turn off cellular phones and other small 

radio units. 

 

 High frequency noise from other devices via an electrical outlet 

 Detect the source of the noise and take measures to break the route, using a noise 

suppressor. 

 Avoid using the noise generating device. 

 Use another electrical outlet. 

 

 Static electricity 

 Fully discharge the operator before use. 

 Humidify the room. 

 

 Lightning strike 

A nearby lightning strike may induce excessive voltage into the device. In the event of a 

lightning strike: 

 Use an uninterruptible power supply to operate the device. 

 

 Using the device introduces noise into a television or radio. 

 Place the affected television or radio away from the device. 
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PRECAUTIONS FOR SAFETY MEASUREMENTS 
Obey the following precautions for safety measurements 

 

1. Blood pressure measurement 

 

 

 When the blood pressure monitor is connected to a personal computer, do not 

place the cuff on a patient. 

 

 

2. Terms and abbreviations 

The tables below list terms and abbreviations used for the blood pressure data analysis software. 
 

Terms and abbreviations related to 
blood pressure measurements 

Description 

Korotkoff: Korotkoff measurement method 
Blood pressure values are obtained by 
detecting the Korotkoff sounds. 

Oscillometric: Oscillometric method 
Blood pressure values are obtained by 
analyzing variations in pulse pressure 
detected in the cuff. 

Systolic, SYS, SBP: Systolic Blood Pressure 
Maximum blood pressure or the blood 
pressure when the heart is contracting 

Diastolic, DIA, DBP: Diastolic Blood Pressure 
Minimum blood pressure or the blood 
pressure when the heart is relaxing 

MAP, MA: Mean Arterial Blood Pressure 

Mean blood pressure obtained by the 
following formula: 

MAP=DIA+(SYS-DIA)/3 

PUL: Pulse Rate Pulse rate 

DP: Double Product 

Oxygen consumption by the heart muscle 
obtained by the following formula:  

DP=SYS×PUL/1000 

BP: Blood Pressure  

BPM: Blood Pressure Measurement  
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Terms and abbreviations related to 
statistical calculations 

Description 

AVE、mean、m Arithmetic mean value 

max Maximum value 

min Minimum value 

SD、S’: Standard Deviation Standard deviation obtained by the following formula: 

n 
[ (Xi-X)2 / (n-1)]1/2  to sample (X1, ...Xn)

 

i=1 

n: number of samples、X: arithmetic mean value 

SE: Standard Error Standard error obtained by the following formula: 

(SD2/n)1/2  to sample (X1, ...Xn) 

CV: Coefficient of Variation Coefficient of variation obtained by the following 
formula: 

CD=SD/mean[%] 

Correlation  

Correlation r: Coefficient of Correlation  

Reg.Line: Regression Line  

Histogram  

c.i.: Confidence Interval  Interval surrounded by the confidence limit of 95%.    

 

Terms and abbreviations related to  
circadian rhythm 

Description 

Cosinor 
Circadian rhythm analysis method introduced by 
Halberg et al (1967). 

MESOR 
A circadian rhythm-adjusted mean based on the 
parameters of a cosine function fitted to the raw 
data. 

AMP: Amplitude 
Amplitude of a cosine curve best fitted to the 
biological rhythm data. 

Acrophase 
Phase that represents the maximum value of a 
cosine curve best fitted to the biological rhythm 
data. 

PR: Percent Rhythm 

Rhythm compatibility 

Squared multiple correlation coefficient (R) 
between the measured value and the cosine 
curve best fitted to the biological rhythm data. 
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Other terms and abbreviations Description 

HBI: Hyperbaric Index High blood pressure index 

Hypobaric Index Low blood pressure index 

Hyperbaric Area 
Time integral of the blood pressure values 
exceeding the user-defined limits 

Hypobaric Area 
Time integral of the blood pressure values 
not reaching the user-defined limits  

HBI-sys 
The limits of the systolic blood pressure to 
HBI 

HBI-dia 
The limits of the diastolic blood pressure to 
HBI 

F Full analysis 

P Partial analysis 

Approximate Curve  

Fourier Series Expansion  

Order  

meas.: measurement  

AVERAGE Trend 

Average trend shows the trend of hourly 
average values for systolic blood pressure, 
diastolic blood pressure, mean arterial blood 
pressure and pulse.  
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1. INTRODUCTION 
Thank you for purchasing the Blood Pressure Data Analysis Software Doctor Pro3 manufactured 

by A&D Company, Ltd. This manual provides information on the operation procedures for Doctor 

Pro3.  

Please read this manual carefully before using Doctor Pro3 in order to acquire sufficient 

information to use the software properly.  

Store the manual in a readily available location for future reference. 

 

 

2. FEATURES 
Doctor Pro3 is a Windows-based Blood Pressure Data Analysis Software that sets the blood 

pressure monitor measurement parameters and saves the collected blood pressure data into a 

personal computer. Doctor Pro3 analyzes blood pressure data for each patient. Doctor Pro3 is a 

powerful tool for diagnosing high blood pressure and managing the blood pressure of patients 

with high blood pressure. 

 

Doctor Pro3 is intended for use with the following blood pressure monitors. 

 TM-2430  ME (Medical Electronics)  Ambulatory Blood Pressure Monitor 

 UA-767PC  ME (Medical Electronics)   Digital Blood Pressure Monitor with communication function 

Doctor Pro3 has the following features. 

Patient data 
management 

The blood pressure data and patient information are saved in a 
personal computer database. The data is separated into groups. 

Statistical analysis Statistical data may be viewed and analyzed in full, partial, sleep, and 
awake sections, by switching between clearly labeled tabs. 

Graphical data 

Systolic/diastolic blood pressure, mean arterial blood pressure, and 
pulse data are displayed graphically to quickly determine patterns or 
data trends. 

Circadian rhythm and HBI analysis are displayed graphically and 
numerically. 

Data conversion 
The Data Convert feature imports or exports the blood pressure and 
pulse data in a standard (CSV) file format for use with popular 
spreadsheet programs. 

Printed reports 
Custom data report formats are easily defined and printed. The “Print 
all” feature allows the user to select specific analytical results to be 
printed and prints a summary report of the selected items. 
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3. SPECIFICATIONS 
 

3-1 Software Package Components 

When unpacking the software, it is important to verify that the following articles are included and 

are in good condition. 

If your software package components are damaged or missing, contact the local A&D dealer you 

purchased the product from.  

 

 CD-ROM       1 disk 

 USB cable AX-KO3057-200 (TM-2430 and UA-767PC)  1 piece 

 Instruction manual     1 copy (This document) 

 

 

 

    

 

 

 

 

         CD-ROM         USB cable AX-KO3057-200 
                                                     (for TM-2430 and UA-767PC) 

 

 

 

 

 

 

 

 

 

 

 

 

    

        Instruction manual 
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3-2  Blood Pressure Monitors compatible with Doctor Pro3 

Doctor Pro3 is intended for use with the following blood pressure monitors. 

TM-2430 

 24-hour ambulatory blood pressure monitoring. Useful for 

research and treatment of high blood pressure. 

  Light weight, approximately 215 g (including batteries).  

 Compact size that fits in a palm. 

 The monitor is powered by LR6 type (Mignon) alkaline 

batteries or Ni-Cd rechargeable batteries. 

 

 

UA-767PC 

  Bi-directional communication with a personal computer 

Penables data analysis and date setting using the Data 

Analysis Software. 

 Stores 280 sets of measurement data. 

 Clock and calendar function. 

 Alarm can be set up to 6 times a day. 

 Useful for monitoring blood pressure treatment, and 

conducting various clinical trials, research on blood 

pressure and home-based monitoring systems. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

TM-2430 

UA-767PC 
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3-3  System Requirements 
Computer Personal computer with a Pentium 4 1GHz or greater 

microprocessor 

Memory Minimum 1GB(32bit) , 2GB(64bit) 

Operation system Windows 8(32bit/64bit), 7(32bit/64bit), Vista(32bit/64bit), or XP(SP2) 

- .NET Framework 3.5 or greater 

- MDAC 2.6 or greater 

Graphic adapter SVGA video card (minimum of 256 colors, 800X600 pixels or higher 

recommended) 

Disk type CD drive (depends on the media) 

Hard disk Minimum 1GB free space 

Interface USB 2.0 / 1.1  

Port USB A socket 

Printer type  Printers supported by the Windows operating system 

 

 

 

 Only a personal computer that complies with the safety requirements of 

IEC60601-1 can be used with this product. If a computer that does not 

comply with those requirements is used, safety will not be guaranteed. 
 

 

3-4 Brief Description on Analysis 

The TM-2430 Ambulatory Blood Pressure Monitor is used to record an individual’s blood pressure 

over an extended period, normally 24-48 hours. The monitor employs the oscillometric method to 

record the patient’s blood pressure based on predetermined periods and parameters. 

 

The user may divide each 24-hour interval into several periods. Within each period, the monitor 

may be programmed to record the patient’s blood pressure at intervals from OFF to 120 minutes. 

These measurement intervals may be timed to coincide with the patient’s daily activities. 

 

With a UA-767PC, blood pressure data collected over a long period (maximum 12 months) can 

be managed and blood pressure trends are indicated clearly by using Doctor Pro3. 

 

Even though the data collected by the old version of Doctor Pro is not directly compatible with the 

data collected by the current version software, data collected by the old version of Doctor Pro can 

be converted to the new version using the importing or exporting function. 
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4. BEFORE USE 
 

4-1  Installing the Software 

The software can only be run from a hard disk drive.  

To install the software on your hard disk drive, complete the following steps: 

 

1. Insert the CD-ROM into a personal computer CD drive. 

2. If the program starts up automatically, go to step 5. Otherwise, click the Start button on 

the Windows taskbar and select [Run].  

3. Type “g:setup”. (g: is the hard disk drive into which the CD-ROM will begin installations.) 

(1) The following appears when the USB driver has not been installed. 

 

 

 

 

 

 

 

 

 

 

 Connect the USB cable supplied with the software to your personal computer and 

click [Setup FTDI USB Device Driver]. 

(2) Specify the CD-ROM Driver folder and install the driver. 

     

(3) When the driver has been installed successfully, click [Finish].
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4. Install Doctor Pro3. 

      

 

 

 

 

 

 

 

 

 

 Follow the instructions in the display. 

 

 

 

 

 

 

 

5. When Doctor Pro3 has been installed successfully, the message “Setup succeeded” 

appears. Click [OK], then click [Exit] to quit the installation mode.  
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4-2 Connecting the Blood Pressure Monitor to a PC 

Connect the blood pressure monitor to your personal computer. 

 

 

 

 When the blood pressure monitor is connected to a personal computer, do 

not place the cuff on a patient. 

 Only a personal computer that complies with the safety requirements of 

IEC60601-1 can be used with this product. If a computer that does not 

comply with those requirements is used, safety will not be guaranteed. 
 

4-2-1 Connecting the TM-2430 to the computer 

Use the USB cable supplied with the software, otherwise communication errors will occur. 

 

 

 

 

 

 

 

 

 

 

Connection between the TM-2430 and the computer 
(The illustration above is not to scale.) 

Connect the blood pressure monitor to a personal computer as follows. 

1. Insert the male end (mini-pin jack) of the USB cable into the monitor.  

2. Insert the male end (USB A plug) of the USB cable into the computer’s USB port. 

Note: Keep the cable connected to the computer unless the port is needed for other 
functions.  

3. Start up Doctor Pro3. 

 

 

 

 

 

 

 

TM-2430

Mini-pin jack

USB A plug

USB cable

Personal computer
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4-2-2 Connecting the UA-767PC to the computer 

Use the USB cable supplied with the software, otherwise communication errors will occur. 

 

 

 

 

 

 

 

 

 

Connection between the UA-767PC and the computer  
(The illustration above is not to scale.) 

Connect the blood pressure monitor to a personal computer as follows. 

1. Insert the male end (mini-pin jack) of the USB cable into the monitor.  

2. Insert the male end (USB A plug) of the USB cable into the computer’s USB port. 

Note: Keep the cable connected to the computer unless the port is needed for other 
functions.  

3. Start up Doctor Pro3. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

UA-767PC

Mini-pin jack

USB A plug

USB cable

Personal computer
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5. MAIN WINDOW 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Quick startup menu 

No. Name Description 

1 New patient Opens the New Patient window to register patient information. 

2 Open database 
Opens the Patients Database window to manage blood pressure 
data. 

3 Receive data 
Opens the Receive Data window to receive blood pressure data 
from the blood pressure monitor. 

4 Send setting data 
Opens the Send Setting Data window to send the data to the 
blood pressure monitor. 

Menu bar 

Name Description 
File Select from “Import,” “Export,” “Optimize a DB” or “Exit.” 
Quick  Same with the quick startup menu. 

Configuration 
Select from “Medical facility,” “Account mode,” “New account,” “Default 
settings,” “Measurement pattern settings” or “Change language.” 

Window Select the window displaying method. 
Help Displays the software version information. 

Tool bar 

No. Name Description 
5 Quick menu  Turns ON or OFF the quick startup menu. 
6 New patient Same with 1. 
7 Open database Same with 2. 
8 Receive data Same with 3. 
9 Send setting data Same with 4. 

10 Medical facility 
Opens the Medical Facility window. Similar to the Configuration 
menu‘s Medical Facility menu. 

Quick startup menu 

① ② ③ 

④ 

Menu bar 

Tool bar 

⑤⑥⑦⑧⑨⑩ 
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6. GENERAL OPERATION 
 

6-1   Starting up Doctor Pro3 
Startup procedure 

1. To startup Doctor Pro3: 

・Click “DrPro3” from the START menu. 

     or 

・Click the [DrPro3] icon located on the desk top. 

 

 

 

2. The Main window opens. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

6-2  Receiving the Data 
Receives the measurement data from the blood pressure monitor.  

For details, refer to Section 9 “RECEIVING DATA.” 

 

1. Click [Receive data] at the quick startup menu. 

 

 

 

 

 

 

 

Receive data 

Quick startup menu 

Quick startup menu 
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2. Click [Next]. 

 

 

 

 

 

 

3. When the connection is complete, the message “Successfully received data” appears in 

the Connect Device window. 

Click [Next]. 

   

 

 

 

 

TM-2430 recognition                UA-767PC recognition 

 

4. The data received is displayed. Click [Next]. 

 

 

 

 

 

 

 

 

 

 

5. The Select Patient window opens. 

 

 

 

 

 

 

 

Click [Next]. 

Click [Next]. 
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6-3 Selecting or Adding a Patient 

Saves the measurement data received. For details, refer to Section 9 “RECEIVING DATA.”  
 

1. Select from the list of registered patients the patient under whose name you would like to 

save data. 

 To select a new patient, click [New patient] to register a new patient. 

 When the patient selection is completed, click [Next]. 

 

 

 

 

 

 

 

 

 

2. Confirm the patient to be registered. Click [Register] and then click [OK] in the Confirm 

window. 

 

 

 

 

 

 

 

 

 

 

3. When the display shown below appears, the patient has been registered. 

 

 

 

 

 

 

 

 

 

 To complete the operation, click [Close]. 

 To continue receiving data, click [Next data].  

Click [Next]. 

Confirm the patient to be registered. 

Click [Register]. 

“Saved” appears. 

To select a new patient, register a new

patient. 

Select a patient. 
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6-4  Analyzing the Measurement Data 

Analyzes the measurement data. 

For details, refer to Section 8 “MANAGING DATA.” 

 

1. Click [Open database] at the quick startup menu. 

 

 

 

 

 

 

 

2. Select the patient data from the group list. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Click the registration date to be analyzed from the Data Registration window. The list of 

measurement data will be displayed in the Measurement Data window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Open database 

Quick startup menu 

Group list 

Measurement Data window 

Patient list registered in each folder. 

Data Registration window 



 

 17 

 

4. Click the registration dates to be analyzed from the Data Registration window and click 

the Select box. 

       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 The following items can be analyzed. For details, refer to “8-6 Data Analysis Window.” 

Menu Refer to 

Select periods 8-6-1 

Summary data 8-6-2 

Trend 8-6-3 

Correlation 8-6-4 

Histograms 8-6-5 

Circadian rhythm 8-6-6 

HBI analysis 8-6-7 

AVERAGE trend 8-6-8 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select periods  
Summary data  

Trend 
Correlation 

Histograms  

Circadian rhythm
 

HBI analysis
 

AVERAGE trend
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6-5  Printing the Data 

Prints the analyzed data.                        

For details, refer to “8-7 Printing the Analyzed Data.” 

 

1. Print preview is available in the Data Registration window. Click [Print all] to print all the 

printable items. 

       

 

 

 

 

 

 

 

 

2. The analyzed results can be printed according to the following categories. 

 For details on settings of [Full] or [Partial], [Sleep] and [Awake], refer to “8-6 Data 

Analysis Window.” 

 

 Printing in the Summary Data window 

 [Full] tab window  Click [Print] to print. 

 [Partial] tab window  Click [Print] to print. 

 [Awake] tab window  Click [Print] to print. 

 [Sleep] tab window  Click [Print] to print. 

 

  Printing in the Trend window 

  [Individual printing]   Prints a trend graph. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the Correlation window 

  [Individual printing]   Prints correlation plots. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the Histograms window 

  [Individual printing]   Prints histograms. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

  

Print preview  

Print all   



 

 19 

 

  Printing in the Circadian Rhythm window 

  [Individual printing]   Prints circadian rhythm plots. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the HBI Analysis window 

  [Individual printing]   Prints HBI analysis plots. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the AVERAGE Trend window 

  [Individual printing]   Prints an hourly average trend graph.  

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 
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7. NEW PATIENTS 
 

1. Click [New patient] at the quick startup menu. 

 

 

 

 

 

 

 

2. Select Group window 

 

 

 

 

 

 

 

 

                                                     Enter information as necessary. 

 

 

 

 

Item Description 
Patient ID (Required) Enter the patient ID using a maximum of 20 characters. 

First name (Required) Enter the patient’s first name using a maximum of 30 characters. 

Last name (Required) Enter the patient’s last name using a maximum of 30 characters. 

Sex Select from the pulldown menu. 

Date of birth Enter in the MM-DD-YYYY format or select from the pulldown 
menu. 

Select group (Required) 

Point the mouse to the group folder.  
To add a group or rename the group, click the [Add group] or 
[Rename group] icon, or right-click to display “Add group” and 
“Rename group.” 

When all the necessary items have been entered, click [Next]. 

New patient 

Quick startup menu 

Data must be entered in these

three fields. 

Required 

[Rename group] icon 

[Add group] icon 
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3. Patient’s Personal Information window  

 

 

 

 

 

 

 

 

 

Item Description 
Height Enter the patient’s height in 0-99999. (Place a decimal point as necessary.) 
Weight Enter the patient’s weight in 0-99999. (Place a decimal point as necessary.) 
Address Enter the patient’s address using a maximum of 50 characters. 

Telephone 
Enter the patient’s telephone number using a maximum of 20 characters 
between 0 to 9 and a hyphen (-). 

E-Mail  Enter the patient’s e-mail address using a maximum of 50 characters. 
Insurance Enter the patient’s insurance carrier. 
Referring physician Enter the doctor’s name using a maximum of 30 characters. 
Medications Enter the patient’s medications using a maximum of 60 characters. 
Comment 1 Enter comments using a maximum of 200 characters. 
Comment 2 Enter comments using a maximum of 200 characters. 
Pattern of meas. 
(Pattern of measurement) 

Select from the pulldown menu. 

When all the necessary items have been entered, click [Next]. 

 

4. Past Illness window 

 

 

 

 

 

 

 

 

 

 

Item Description 
Diabetes Select from “No,” “Yes” and “Unknown.” 
Hypertension Select from “No,” “Yes” and “Unknown.” 
Hyperlipidemia Select from “No,” “Yes” and “Unknown.” 
Obesity Select from “No,” “Yes” and “Unknown.” 

When all the necessary items have been entered, click [Next]. 

Then, click [Register]. The Confirm window opens. 

Enter information as necessary. 

Enter information as necessary. 



 

 22 

 

5. Confirm window 

 

 Click [OK] to register the new patient. 
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8. MANAGING DATA 
Manages the group and patient database. 

Click [Open database] at the quick startup menu. 

 

 

 

 

 

 

 

Patients Database window 

   

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click a folder in the group list. The relevant data is displayed in the patient list. 

 

 

 

 

 

 

 

 

 

 

 

Open database 

Quick startup menu 

Group list 

Patient list 

Closes this window. 
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8-1 Editing the Group List 

Adds or renames a group, and performs a search.  

 

NOTE 

Adding and renaming a group can be performed either by clicking on each icon or by 

right-clicking the group folder. 

 

8-1-1  [Add group] 
(1) Click the folder into which a group will be added.  

(2) Click the [Add group] icon. 

(3) A new folder is added. 

(4) Enter the group name. 

 

 

 

 

 

 

8-1-2  [Rename group]  
Note: Patient names can not be changed. 

(1) Click a folder to rename. 

(2) Click the [Rename group] icon. 

(3) Enter a group name. 

 

 

 

 

 

 

 

 

8-1-3  [Search]  
(1) Click the [Search] icon to open 

the Search Data window. 

(2) Enter search items. 

(3) Click [Search]. 

(4) The search results will be 

displayed. 
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8-2  Editing the Patient List 

Adds a patient.                                                                                       

 
8-2-1  [New patient] 
(1) Click a folder from the group list into which a patient will be added. 

(2) Click the [New patient] icon to open the Simple Registration window. 

 

Enter the following items. 

 Patient ID (Required) 

 First name (Required) 

 Last name (Required) 

 Date of birth 

 Sex 

 

 When all the necessary items have been entered, click [Register]. 

 

(3) The Confirm window opens. 

    

 

 

 

 

 

 

 

 

(4) Click [OK] to add the patient. 

 Click [Close] to complete the operation. 
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8-3 Data Registration Window 

Displays and prints the analyzed results of measurement data. 

 

8-3-1 Opening the data registration window 

Click a patient name from the group list to open the Data Registration window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Items in the Data Registration window 

Item Description 
Registration date Displays the date when the data is uploaded (received). 
Device Displays the model of the blood pressure monitor that was used. 
W (Wake time) Displays the wake time. 
B (Bedtime) Displays the bedtime. 
Select Click the box to include in data analysis. 

CSV 

Displays a data format. 
2C: CSV-imported data format of Doctor Pro2 
2D: DAT-imported data format of Doctor Pro2 
3C: CSV-imported data format of Doctor Pro3 
Blank: Standard measurement data 

 

 

NOTE 

The CSV column is usually not displayed. To display the column, adjust the column widths 

of the Data Registration window. 

 

 

 

Data Registration window 

Group list 
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8-3-2 Selecting an analysis icon 

Click on an icon in the Data Registration window to perform various analyses. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Click the Select box from the registration date to perform various analyses. 
When the TM-2430 is used, select a maximum of two data.  

 

 Analysis menu 

Menu Refer to Description 

Select periods 8-6-1 
Defines specific periods of time within an opened data 
file for custom data analysis. Two periods, full analysis 
and partial analysis may be defined for each data file. 

Summary data 8-6-2 Displays statistical data. 

Trend 8-6-3 
Displays systolic blood pressure, diastolic blood 
pressure, mean arterial blood pressure, pulse (heart 
rate) and double product trends. 

Correlation 8-6-4 

Displays correlation plots of systolic blood pressure to 
diastolic blood pressure, and diastolic blood pressure 
to pulse.  

The scatter diagram allows easy observation of the 
correlation between systolic and diastolic blood 
pressures; the minimum and maximum values, the 
magnitude of fluctuation and the density of a 24-hour 
blood pressure data. 

 

Select periods

 
Summary data

 
Trend

 
Correlation

 
Histograms

 
Circadian rhythm

 HBI analysis

 AVERAGE trend
 Ascending order

 Descending order
 Selection release

 Print preview
 

Print all  
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 Menu Refer to Description 

Histograms 8-6-5 

Displays the frequency distribution of the 
measurement data. 

Allows easy observation of the data that occurs the 
most frequently, the frequency distribution and the 
distribution width during the analysis period. 

Circadian rhythm 8-6-6 

Displays the cosinor analysis graph, the graph 
showing the estimated amplitude and peak position 
based on the 95% confidence interval, and the 
numerical data. 

Note: Not available with the UA-767PC. 

HBI analysis 8-6-7 

Displays the graph showing the hyperbaric area and 
hypobaric area, and the numerical data converted into 
a one-day period. 

Hyperbaric: that area exceeding the user-defined 
limits for the sleep and awake sections. 

Hypobaric: that area not reaching the user-defined 
limits for the sleep and awake sections. 

Note: Not available with the UA-767PC. 

AVERAGE trend 8-6-8 
Displays the trend of hourly average values for 
systolic blood pressure, diastolic blood pressure, 
mean arterial blood pressure and pulse (heart rate). 

Ascending order  Sorts the registration date in the ascending order. 
Descending order  Sorts the registration date in the descending order. 
Selection release  Removes the check mark from the select box. 

Print preview 8-7-1 
Displays a print preview of the data selected from the 
registration date. 

Print all 8-7-2 
Select graph options, set printing parameters and 
print. 

 

When the registration date column is double-clicked, the Export Data window opens. For details, 

refer to “11-2 Exporting Files.” 
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8-4  Measurement Data Window 

Displays measurement data in detail. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Items in the Measurement Data window 

Item Description 
No. Measurement No. 
Measurement time Date and time when the measurement is performed. 
SYS Systolic blood pressure 
DIA Diastolic blood pressure 

MAP 
Mean arterial blood pressure, obtained by 
MAP=DIA+(SYS-DIA)/3. 

Pulse Pulse rate 
DP Double Product, obtained by DP=SYS×Pulse/1000. 

Events 
Only for the TM-2430. Displays the measurement during sleep or 
manual measurement. 
(Always “0” for the UA-767PC.) 

Meas. method 
(Measurement method) 

Displays the measurement method, Korotkoff or oscillometric. 

Errors 
Displays individual errors. 
(Displays error codes for the TM-2430.)  
(Always “0” for the UA-767PC.) 

Suppressed Click the data to exclude from data analysis. 
Comments Enter comments using a maximum of 20 characters. 

Scroll bars 
Located at the bottom and right of the screen to scroll the data. 
Data can also be scrolled using the arrow keys or the mouse. 

 

 

 

Measurement Data window 
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8-4-1 Switching the measurement data window 

Clicking the icon in the Measurement Data window switches the window as follows. 

 

 BP Data List window 

 

 

 

 

 

 

 

 Simple Trend window 
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8-5  Patient Information window 

Edits the patient’s personal information and device information. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The Patient Information window has three tabs. 

・[Meas. info.] tab to edit the device information.  

 

 

 

 

 

 

 

・[Personal details] tabs to edit the patient’s personal information.  

 

Patient Information window 
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Item Description 
Patient ID (Required) Enter the Patient ID using a maximum of 20 characters. 
First name (Required) Enter the patient’s first name using a maximum of 30 characters. 
Last name (Required) Enter the patient’s last name using a maximum of 30 characters. 

Date of birth 
Enter in the MM-DD-YYYY format or select from the pulldown 
menu. 

Sex Select from the pulldown menu. 
Wake time Enter in the 24-hour format. 
Bedtime Enter in the 24-hour format. 
Device Select from the pulldown menu. 

Recorder ID 
Enter the recorder ID using a maximum of 2 characters between 
0 to 9. 

Pressure Select from the pulldown menu. 
Cuff size Select from the pulldown menu. 
Display Select from the pulldown menu. 
Buzzer Select from the pulldown menu. 
Meas. pattern (Pattern 
of measurement) 

Select from the pulldown menu. 

Height 
Enter the patient’s height in 0-99999. (Place a decimal point as 
necessary.) 

Weight 
Enter the patient’s weight in 0-99999. (Place a decimal point as 
necessary.) 

Address Enter the patient’s address using a maximum of 50 characters. 

Telephone 
Enter the patient’s telephone number using a maximum of 20 
characters between 0 to 9 and a hyphen (-). 

E-Mail 
Enter the patient’s e-mail address using a maximum of 50 
characters. 

Insurance Enter the patient’s insurance carrier.. 
Referring physician Enter the doctor’s name using a maximum of 30 characters. 

Medications 
Enter the patient’s medications using a maximum of 60 
characters. 

Comment 1 Enter comments using a maximum of 200 characters. 
Comment 2 Enter comments using a maximum of 200 characters. 
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8-6  Data Analysis Window 

The Data Registration window has data analysis icons.  

Select data in the Data Registration window, set the analysis period and click each analysis icon 

to analyze data. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8-6-1  Select periods 
Sets the analysis period of the data selected in the Data Registration window. Without selecting 

periods, analysis will not be performed. 

 

 

 

 

 

 

 

 

(1) Select “Total” or “Total + Interval Analysis” for the analysis period. 

(2) Set the starting date and time and the period, using the scroll bars. 

 

  

Select periods  
   

Summary data   
   

Trend
  
   

Correlation

  
   

Histograms

  
   

Circadian rhythm

  
   

HBI analysis

  
   

AVERAGE 

t   
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(3) Click [Apply]. 

    

 

 

 

 

 

 

 

 

 

 

(4) The Confirm window opens. Click [OK]. 

(5) Click [Close] to complete the operation. 

 
8-6-2  Summary data 

Displays statistical data. The Summary Data window has the following four tabs: 

[Full] ：Statistics based on all the data within the file 

[Partial]  ：Statistics based on the data in the specified period. 

[Awake]  ：Statistics based on the data during the waking hours.   

Note:  Waking hours are specified as those hours outside the identified sleeping 
hours. 

[Sleep]  ：Statistics based on the data during the specified sleeping hours. 

Note:  Sleeping hours are specified as those hours outside the identified waking 
hours. 

 

To open, print and close the Summary Data window, follow the procedure below. 

 

(1) Click the [Summary Data] icon to open the Summary Data window. 
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(2) Click one of the four data tabs, Full, Partial, Awake or Sleep. The Full tab will always be 

enabled.  

 The Partial, Sleep and Awake tabs will be enabled after they are specified. To enable the 

Partial tab, select “Total + Interval Analysis” for the analysis period. To enable the Sleep and 

Awake tabs, enter the wake time and the bedtime in the Patient Information window. 

(3) To print the data for an individual Summary Data tab, select the tab you want to print and click 

[Print] on the lower left side of the window 

(4) Click [Close] to close the Summary Data window. 

 

Each of the four summary data is titled with the name of the tab and the patient name. For 

detailed information on Summary Data window items, see below: 

Item Description 

Section range 
The analysis period, starting date and time – ending date and 
time, for the activated Summary Data tab. 

Valid readings 
The total number of measurements taken during the analysis 
period, excluding any measurement errors or manually 
excluded readings. 

Excluded readings 
The combined total of measurement errors and manually 
excluded readings, and its percentage to the total number of  
measurements.  

MIN (Minimum) 
The minimum value for Systolic, Diastolic, MAP and Pulse 
measurements during the analysis period. 

AVE (Average) 
The average value for Systolic, Diastolic, MAP and Pulse 
measurements during the analysis period. 

MAX (Maximum) 
The maximum value for Systolic, Diastolic, MAP and Pulse 
measurements during the analysis period. 

SD (Standard Deviation) 
The Standard Deviation of the value for Systolic, Diastolic, 
MAP and Pulse measurements during the analysis period. 

SE (Standard Error) 
The Standard Error of the value for Systolic, Diastolic, MAP 
and Pulse measurements during the analysis period. 

CV(%)                    
(Coefficient of Variation) 

The Coefficient of Variation for Systolic, Diastolic, MAP and 
Pulse measurements during the analysis period. 

SYS/DIA limits Systolic and Diastolic limits for the Awake and Sleep sections. 

Readings > SYS limit(s) 
The percentage of the Systolic measurement values greater 
than the specified Systolic limit. Refer to “12-4 Default Settings" 
for information on specifying the Systolic Blood Pressure Limit.  

Readings > DIA limit(s) 

The percentage of the Diastolic measurement values greater 
than the specified Diastolic limit. Refer to “12-4 Default 
Settings" for information on specifying the Diastolic Blood 
Pressure Limit. 

Highest SYS (Systolic Value) 
The highest Systolic value, and the date and time when the 
value is obtained during the analysis period. 

Lowest SYS (Systolic Value) 
The lowest Systolic value, and the date and time when the 
value is obtained during the analysis period. 

Highest DIA (Diastolic Value) 
The highest Diastolic value, and the date and time when the 
value is obtained during the analysis period. 

Lowest DIA (Diastolic Value) 
The lowest Diastolic value, and the date and time when the 
value is obtained during the analysis period. 
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8-6-3  Trend 

Displays trends in a patient’s blood pressure, pulse, MAP and DP calculation over time. The 

Trend window is a useful tool to observe the patient’s circadian rhythm. 

  

The Trend function is dependent on the following parameters: 

1. Analysis period 

2. Measurement Method 

3. Sleep section 

4. Blood pressure limits 

 

(1) TM-2430 

When the TM-2430 is used, the following four trends can be displayed in the Trend window: 

 Systolic/Diastolic Blood Pressure (BP Trend) 

 The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis 

represents time. A vertical solid line connects the measurement’s systolic and diastolic 

pressures. This line may be used to estimate the pulse pressure. 

 Pulse (Pulse Trend) 

 The vertical axis represents beats per minute (bpm) and the horizontal axis represents 

time. The pulse trend is represented by yellow dots. 

 Mean Arterial Blood Pressure (MAP Trend) 

 The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis 

represents time. The MAP Trend may be displayed on its own or in combination with the 

BP Trend. If the MAP Trend is combined with the BP Trend, it will appear between the 

Systolic and Diastolic Trend lines. 

 Double Product 

 The vertical axis represents mmHg･bpm/1000 and the horizontal axis represents time. 

Icons in the Trend window 

 

     

      

 

 

 

 

 

 

 

 

 

 

1 2 3 4 5 6 

7 

8 

9 
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No. Icon Description 
1 Individual printing Prints a trend graph. 

2 Print all 
Opens the Conclusion Printing window.  
Select graph options, set printing parameters and 
click [Print]. 

3 List Disp/Not-Disp 
Selects whether or not to display the list of 
measurement data below the trend graphs. 

4 Select periods 

Defines specific periods of time within an opened 
data file for custom data analysis. Two periods, full 
analysis and partial analysis may be defined for each 
data file. 

5 Close Closes the Trend window. 
6 Left/right arrows Moves the cursor to the left or right. 
7 Config graph Changes the graph axes settings. 

8 Select graph 
Click the box to display the graph, or if there is a 
check mark in the box and no graph is needed, click 
the box to remove the check mark. 

9 Suppressed data 
Selects whether or not to display the data excluded in 
the list of measurement data in a graph. 

Click the [Close] icon or [X] in the upper right corner to close the Trend window. 
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(2) UA-767PC 

When the UA-767PC is used, the following four trends can be displayed in the Trend window: 

 Systolic/Diastolic Blood Pressure (BP Trend) 

 The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis represents time. 

The systolic pressure is represented by a solid red line; the diastolic pressure by a solid green line. 

 Pulse (Pulse Trend) 

 The vertical axis represents beats per minute (bpm) and the horizontal axis represents 
time. The pulse trend is represented by yellow dots. 

 Mean Arterial Blood Pressure (MAP Trend) 

 The vertical axis represents millimeters of mercury (mmHg) and the horizontal axis 
represents time. The MAP Trend may be displayed on its own or in combination with the 
BP Trend. If the MAP Trend is combined with the BP Trend, it will appear between the 
Systolic and Diastolic Trend lines as a solid blue line. 

 Double Product 

 The vertical axis represents mmHg･bpm/1000 and the horizontal axis represents time. 

Icons in the Trend window 

 

 

 

 

 

 

 

 

 

 

 

 

 

No. Icon Description 
1 Individual printing Prints a trend graph. 

2 Print all 
Opens the Conclusion Printing window.  
Select graph options, set printing parameters and click [Print]. 

3 List Disp/Not-Disp 
Selects whether or not to display the list of measurement data below 
the trend graphs. 

4 Select periods 
Defines specific periods of time within an opened data file for custom 
data analysis. Two periods, full analysis and partial analysis may be 
defined for each data file. 

5 Close Closes the Trend window. 
6 Config graph Changes the graph axes settings. 

7 Select graph 
Click the box to display the graph, or if there is a check mark in the 
box and no graph is needed, click the box to remove the check mark. 

8 Suppressed data 
Selects whether or not to display the data excluded in the list of 
measurement data in a graph. 

9 Slider bar Moves the range of the displaying date and time back and forth. 

Click the [Close] icon or [X] in the upper right corner to close the Trend window. 

6 

7 

8 

9 

1 2 3 4 5 
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8-6-4  Correlation 

The Correlation window offers a convenient way to view the relationship between the blood 

pressure parameters. Both Full and Partial Analysis Correlation Plots may be viewed for the 

following relationships: 

1. Systolic versus Diastolic 

2. Systolic versus Pulse (Heart Rate) 

3. Statistical Data: Systolic, Diastolic, Pulse 

- Average 

- Standard Deviation, [SD] 

- Correlation Coefficient, [r] 

- Regression Line 

 

The vertical axis represents systolic pressure, the horizontal axis represents the diastolic 

pressure on the left hand graph and pulse on the right hand graph. All the graphs have scales of 

0 to 300 mmHg.   

 

Note: If Partial Analysis is enabled, four graphs will appear. The first two graphs in the 
upper part of the window, in blue, are based on Full data. The second pair of 
graphs, in red, in the lower part of the window are created from valid data 
specified within Partial Analysis parameters. 

 

Click the [Close] icon or [X] in the upper right corner to close the Correlation window. 
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8-6-5  Histograms 

The Histograms window offers a convenient way to quickly review the frequency distribution of 

the systolic, diastolic, mean arterial blood pressures, pulse (heart rate) measurements and DP,  

and the statistical data (average and standard deviation for each item).  

 

Note: If Partial Analysis is enabled, the Histograms based on Full data are indicated in 
blue and the Histograms created from valid data specified within Partial Analysis 
parameters are indicated in red. 

The vertical scale represents 0 to 300 (mmHg or bpm) on all graphs except Double Product. The 

horizontal scale represents the percentage of total readings that occurred at the corresponding 

vertical level. The Histograms are displayed in blocks that represent a range of readings. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the [Close] icon or [X] in the upper right corner to close the Histograms window. 
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8-6-6  Circadian Rhythm 

The Circadian Rhythm window shows the circadian rhythm of the systolic and diastolic blood 

pressures, and pulse (heart rate); obtained using the 24-hour cosinor analysis. The analysis 

starting time coincides with the starting time specified for the Full Analysis period. 

The Circadian Rhythm window also shows the amplitude and peak value of the cosine wave 

based on the 95% confidence interval. The systolic blood pressure data is indicated in red, the 

diastolic blood pressure data, in blue, and the pulse data, in yellow. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click the [Close] icon or [X] in the upper right corner to close the Circadian Rhythm window. 
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8-6-7  HBI Analysis  

The HBI Analysis window shows two graphs arranged vertically.  

The upper graph shows the hyperbaric area (in red) exceeding the user-defined hyperbaric limits for 

the systolic and diastolic blood pressures, and the numerical data converted into a one-day period. 

The lower graph shows the hypobaric area (in red) not reaching the user-defined hypobaric limits for 

the systolic and diastolic blood pressures, and the numerical data converted into a one-day period.  

For both graphs, the analysis starting time coincides with the starting time specified for the Full 

Analysis period. 

 

Click the [Close] icon or [X] in the upper right corner to close the HBI Analysis window. 
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8-6-8  AVERAGE Trend 

The AVERAGE Trend window shows the trend of hourly average values for systolic blood 

pressure, diastolic blood pressure, mean arterial blood pressure and pulse (heart rate). 

 

 

 

 

 

 

 

 

 

 

 

Click the [Close] icon or [X] in the upper right corner to close the AVERAGE Trend window. 
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8-7 Printing the Analyzed Data 

The analyzed data can be printed in the Data Registration window.  

 

 

 

 

 

 

 

 

 

 

 

 

8-7-1 Printing procedure from the print preview window 

(1) Select the registration date and click the [Print preview] icon ( ). 

  

 

 

 

 

 

 

 

 

(2) Click boxes as necessary in “Graph option” to print, and select the printing parameters from 

the pulldown menu. 

 

 

 

 

 

 

 

 

 

 

 

(3) Click [Preview]. 

  

Print preview  
Print all 
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(4) The Print Preview window opens. (The number of pages depends on the data selected. The 

example below is the print preview when all the items are selected in “Graph option.” ) 

   Page 1 (Summary+Trend)             Page 2 (List)    Page 3 (Correlation) 

   

 

 

 

 

 

 

 

 

      Page 4 (Histograms)         Page 5 (Circadian rhythm)        Page 6 (HBI analysis) 

 

 

 

 

 

 

 

 

 

   Page 7 (AVERAGE trend) 

 

 

 

 

 

 

 

 

 

 

(5) Click the [Print all] icon ( ). The Conclusion Printing window opens. 

 

(6) Change the settings in the Conclusion Printing window, if necessary. 

 

(7) Click [Print]. 
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8-7-2 Printing procedure without displaying the print preview 

(1) Click the [Print all] icon. 

 

 

 

 

 

 

 

 

 

 

 

 

 (2) Click boxes as necessary in “Graph option” to print, and select the printing parameters from 

the pulldown menu. 

 Select “Mini report” to print the summary data, trend and data list. 

 Select “Trend DP” to print the trend of double product. 

 

(3) Click [Print]. 
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8-7-3  Printing from each analysis window 

 Printing in the Summary Data window 

[Full] tab window    [Partial] tab window 

  

 

 

 

 

 

 

 

 

Click [Print].                                 Click [Print]. 
 

[Awake] tab window     [Sleep] tab window 

  

 

 

 

 

 

 

 

 

Click [Print].                                 Click [Print]. 

 

  Printing in the Trend window 

  [Individual printing]   Prints a trend graph. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the Correlation window 

  [Individual printing]   Prints correlation plots. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 
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  Printing in the Histograms window 

  [Individual printing]   Prints histograms. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the Circadian Rhythm window 

  [Individual printing]   Prints circadian rhythm plots. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the HBI Analysis window 

  [Individual printing]   Prints HBI analysis plots. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 

 

  Printing in the AVERAGE Trend window 

  [Individual printing]   Prints an hourly average trend graph. 

  [Print all]   Click boxes as necessary in “Graph option” to print, and 

select the printing parameters from the pulldown menu. 
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9. RECEIVING DATA 
Receives the measurement data from the blood pressure monitor.  

1. Click [Receive data] at the quick startup menu. 

 

 

 

 

 

 

 

 

2. In the Settings window, select the option to perform after receiving the data. 

 

 

 

 

 

 

 

 

 

 

 Click [Next]. 

 

3. Receiving the data from the blood pressure monitor has begun. 

 

 

 

 

 

 

 

 

 

 

NOTE (Only for the UA-767PC) 

While the PC is in communication with the blood pressure monitor, ” ---“ appears in the 

blood pressure monitor display. For details, refer to the blood pressure monitor instruction 

manual. 

Receive data 

Quick startup menu 

Clearing the data 

When “Clear data” is selected, the data in the

monitor will be cleared after receiving the data. 

Adjusting the time 

When “Adjust time of ABPM” is selected, the clock 

of the monitor will be synchronized with the

computer clock after receiving the data. 
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4. When data receiving has been completed, a message appears in the Connect Device 

window. 

   Connected to TM-2430           Connected to UA-767PC 

 

 

 

 

 

 

 

 Click [Next]. 

 If an error occurs, click [Retry] to make a connection again. 

 

5. The data received is displayed. 

 

 

 

 

 

 

 

 

 

 

 Click [Next]. 

 

6. Specify a file/folder to save the data. 

 Select from the list of registered patients the patient under whose name you would like to 

save data. 

 When a new patient is to be used, register the new patient beforehand. 

 

 

 

 

 

 

 

 Click [Next]. 

The message “Successfully received data” appears. 

Click [Next]. 

When a new patient is to be 

used, register the new

patient beforehand. 

Select a patient file/folder. 
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・ Click [New patient] to open the New Patient window and register a new patient. 

   New Patient window 

 

 

 

 

 

 

 

 

7. Confirm the patient to be registered and click [Register]. 

 

 

 

 

 

 

 

 

 

 
 

8. The message “Saved” appears and data registration has been completed. 

 

 

 

 

 

 

 

 

 

 

 To continue receiving data, click [Next data]. 

 To complete the operation, click [Close]. 

 

 

These three items are required. 

After entering the necessary items, click [Add]. 

Confirm the patient to be registered. 

Click [Register]. 

The message “Saved” appears. 
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10. SENDING THE SETTINGS 
Using Doctor Pro3, the settings of the blood pressure monitor can be changed. 

 

10-1 Automatic Recognition of the Blood Pressure Monitor 

1. Click [Send setting data] at the quick startup menu. The Send Setting Data window opens. 

 

 

 

 

 

 

 

 

2. Click [Next]. The connected blood pressure monitor is automatically recognized. 

    

 

 

 

 

 

 

 

 

 

 

3. When a connection has been completed, a message appears. 

Auto detection of TM-2430          Auto detection of UA-767PC 

 

 

 

 

 

 

 

 

Confirm that the monitor model is correct. 

Click [Next]. 

 

Send setting data 

Quick startup menu 

The message “Successful automatic recognition of the BP” appears. 
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10-2  Device Information and Measurement Intervals 
 

NOTE 

Three modes available in the Measurement Intervals window are as follows: 
Mode 1: 07:00-21:59 The measurement is performed every 15 minutes. 
 22:00-06:59 The measurement is performed every 30 minutes. 
Mode 2: The AUTO ON/OFF key is pressed at wake time and bedtime so that the 

measurement intervals are changed and the time during sleep can be 
distinguished on the data. 

 When the Sleep button is off, the measurement is performed every 15 
minutes. 

 When the Sleep button is displayed, the measurement is performed every 30 
minutes. 

Mode 3: The measurement intervals can be set within a maximum of 24 hours. 
 Select from different measurement patterns. 

 

◆TM-2430 

Device Information window 

 

1. Enter Recorder ID. 

2. Select the items below from the 

pulldown menu. 

 Cuff size 

 Display 

 Clear data 

 Adjust time 

 

Click [Next]. 

 

Measurement Intervals window 

Select a mode from Modes 1-3. 

When Mode 3 is selected, set Interval 

for free settings. Select a starting time 

in hours and the interval from the 

pulldown menu. Select “OFF” for the 

interval when no partial analysis is 

performed. When a measurement 

pattern, which is set in “Measurement 

pattern settings,” is to be used, click 

the Select Pattern box and select a 

pattern from the pulldown menu. 

 Click [Next]. 
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◆UA-767PC 

Device Information window 

 

Select the items below from the 

pulldown menu.  

 Buzzer 

 Clear data 

 Adjust time  

 

 

 

Click [Next]. 

 

 Measurement Intervals window 

Set Interval for free settings. Select a 

starting time in hours and the starting 

time in minutes from the pulldown 

menu and click the Valid box to use. 

When a measurement pattern, which 

is set in “Measurement pattern 

settings,” is to be used, click the Select 

Pattern box and select a pattern from 

the pulldown menu.  

Click [Next]. 
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10-3  Confirming the Settings and Data Transmission 

1. Confirm the settings and click [Apply]. 

 

 

 

 

 

 

 

 

 

 

Click [Next]. 

 

2. Data transmission has started. 

 A message appears when the transmission has been completed. 

Sent to TM-2430                    Sent to UA-767PC 

 

 

 

 

 

 

 

 

 To continue sending data, click [Next]. 

 To complete the operation, click [Close]. 

 

 

 

 

 

 

 

 

 

 

 

 

The message “Setting successful” appears. 

Confirm the settings. 

Click [Apply] when the settings are correct. 
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11. FILE MENU 
Importing files and exporting files are available in the file menu of the Main window. 

Data of the DrPro2/3 CSV Exports Files and DrPro2 DAT Exports Files can be used. 

 

11-1  Importing Files 

1. Click “Import” from the File menu of the Main window. 

  

 

 

 

 

 

 

 

2. Click [Import]. 

  

 

 

 

 

 

 

 Click the Import to box to specify the importing destination folder. 

 

3. Specify the importing destination folder and click [Import]. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click [Import]. 

 

 

Click [Import]. 
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4. Select the importing source folder. Select a file and click [Open]. The file has been imported to 

the specified folder. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

1. Select the importing source folder. 

2. Select a file. 

3. Click [Open]. 
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11-2  Exporting Files 

1. Click “Export” from the File menu of the Main window. 

   

 

 

 

 

 

2. Search the data to export. 

 Enter folders, Patient ID, patient name and date to search, and click [Search]. 

3. Select data to export from the list displayed. 

4. Select the items below. 

 Number of files to output : Separate file(s), Merge files 

 File type : DrPro3 CSV, DrPro2 CSV, DrPro2 DAT 

5. Click [Export]. 

   

 

 

 

 

 

 

 

 

6.  Select the exporting destination folder and enter a file name. Click [Save]. The file has 

been exported. 

    

1. Select the exporting destination folder. 

2. Enter a file name. 

3. Click [Save]. 
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11-3  Optimizing a Database 

1. Click “Optimize a DB” from the File menu of the Main window. 

 

 

 

 

 

 

 

2. The Confirm window opens. 

 

 

 

 

 

 Click [OK] to optimize the database. 
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12. CONFIGURATION 
The Configuration menu has the following sub menus. 

 Medical Facility 

 Account Mode 

 New Account 

 Default Settings 

 Measurement Pattern Settings 

 Change Language 

 

12-1  Medical Facility 

1. Click “Medical Facility” from the Configuration menu of the Main window. 

   

 

 

 

 

 

 

2. Enter each item and click [Register]. The Confirm window opens. Click [OK] to register 

the medical facility. 

   

 

 

 

 

 

 

 

 

Item Description 
First name  Enter the first name using a maximum of 30 characters. 
Last name Enter the last name using a maximum of 30 characters. 
Hospital name Enter the hospital name using a maximum of 50 characters. 
Address Enter the hospital address using a maximum of 50 characters. 

Telephone 
Enter the hospital telephone number using a maximum of 20 
characters between 0 to 9 and a hyphen (-). 

E-mail 
Enter the hospital e-mail address using a maximum of 50 
characters. 

  

 

 

 



 

 61 

12-2  Account Mode 

1. Click “Account Mode” from the Configuration menu of the Main window. 

   

 

 

 

 

 

 

2. Select either single account or multi account and click [Register]. 

   

 

 

 

 

 

 

 

 The Confirm window opens. Click [OK] to change the account mode. 

 

 

12-3  New Account 

1. Click “New Account” from the Configuration menu of the Main window. 

   

 

2. Enter account names and passwords for multi accounts. Select authority. 

 Click [New], [save] or [Delete] to add, update or delete the account. 
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   When [Close] is clicked, new account registration has been completed. 

 

NOTE 

When logged in, into the single account mode right after installation, if the user changes 

to the multi account mode and restarts, logging in will no longer be available because the 

account and password have not been registered. 

 

 

 

 

 

 

 

 

 

If the condition above occurs, enter the items below to log in. 

 Account : Administrator, Password : sys 

 

 

 

12-4  Default Settings 

1. Click “Default Settings” from the Configuration menu of the Main window. 

      

 

 

 

 

 

 

 

 



 

 63 

2. Enter each item and click [Register]. The Confirm window opens. Click [OK] to register 

the default settings. 

 

 

 

 

 

 

 

 

 

 

 

Item Description 

BP/Pul Low 
Select the lowest value for the BP/Pul axis from 
the pulldown menu. 

BP/Pul High 
Select the highest value for the BP/Pul axis from 
the pulldown menu. 

DP Low 
Select the lowest value for the DP axis from the 
pulldown menu. 

DP High 
Select the highest value for the DP axis from the 
pulldown menu. 

ABPM range 
Select the value for the time axis from the 
pulldown menu. (For TM-2430) 

BPM range 
Select the value for the time axis from the 
pulldown menu. (For UA-767PC) 

Priority display Select from the pulldown menu. 
Hyperbaric limit for systolic in awake section Enter the value. 
Hyperbaric limit for diastolic in awake section Enter the value 
Hyperbaric limit for systolic in sleep section Enter the value 
Hyperbaric limit for diastolic in sleep section Enter the value 
Hypobaric limit for systolic in awake section Enter the value 
Hypobaric limit for diastolic in awake section Enter the value 
Hypobaric limit for systolic in sleep section Enter the value 
Hypobaric limit for diastolic in sleep section Enter the value 

 

 Hyperbaric limit:   

 The percentage of readings exceeding the specified Systolic and Diastolic limits for the 

Awake and Sleep sections will be calculated and noted both in the summary data and 

printed reports. 

 The values are used as “limits” for HBI analysis. 

 

 Hypobaric limit:   

 The percentage of readings not reaching the specified Systolic and Diastolic limits for the 

Awake and Sleep sections will be calculated and noted both in the summary data and 

printed reports. 

 The values are used as “limits” for HBI analysis. 
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12-5  Measurement Pattern Settings 

1. Click “Measurement Pattern Settings” from the Configuration menu of the Main window. 

    

 

 

 

 

 

 

 

 

2. Set measurement patterns for Mode 3. Enter each item and click [Register]. The Confirm 

window opens. Click [OK] to set the measurement pattern. 

 To delete a setting, click [Delete], and click [OK] for the message “Delete?”. 

   

 

 

 

 

 

 

 

 

 

Item Description 
Name Name the measurement pattern. 

Start time Hour 
Select a measurement starting time in hours from the pulldown 
menu. 

Start time Minute 
Select a measurement starting time in minutes from the pulldown 
menu. 

Interval (min.) Select an interval from the pulldown menu. 
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12-6  Changing Languages 

1. Click “Change Language” from the Configuration menu of the Main window. 

     

 

 

 

 

 

 

 

2. In the Change Language window, select the language to be used and click [OK]. 

Changing languages has been completed. 
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13. WINDOW MENU 
The Window menu has the following sub menus. 

 Cascade 

 Horizontal 

 Vertical  

 Minimization 

 

13-1    Cascade 

1. Click “Cascade” from the Window menu of the Main window. 

    

 

 

 

 

 

 

 

 

 The opened windows will be cascaded. 
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13-2    Horizontal 

1. Click “Horizontal” from the Window menu of the Main window.  

   

 

 

 

 

 

 

 

 The opened windows will be arranged horizontally. 

  

 

 

 

 

 

 

 

 

 

 

Note: When more than three windows are opened, the “Horizontal” and “Vertical 
functions arrange the opened windows in the same way. 
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13-3     Vertical 

1. Click “Vertical” from the Window menu of the Main window. 

  

 

 

 

 

 

 

 

 The opened windows will be arranged vertically.  

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: When more than three windows are opened, the “Horizontal” and “Vertical 
functions arrange the opened windows in the same way. 
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13-4     Minimization 

1. Click “Minimization” from the Window menu of the Main window. 

   

 

 

 

 

 

 

 

 An opened window will be reduced to an icon. 

   

 

 

 

 

 

 

 

 

 

 

 

 To restore the window to the original size, double-click on the reduced icon. Or click the 

icon and select “Restore to the original size” or “Maximize.” 
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14.  MAINTENANCE 
 

14-1  Error Codes 
 

14-1-1 TM-2430 

The table below lists the errors that may occur during a monitoring session and offer information 

on probable causes and corrections. 

Measurement errors may be shown on the list of measurement data or the blood pressure 

monitor. 

 
Error code Probable cause Correction 

E00 Clock parameters have 
not been set. 

Enter the clock parameters. 

E03 The cuff does not inflate. Exhaust the air from the cuff completely. 

E04 Measurement is stopped 
due to a low battery. 

Replace the batteries with new ones. 
Restart the Auto mode if you use it. 

E05 
Inflation pressure does 
not reach the target 
pressure. 

Rewrap the cuff and reconnect it to the blood 
pressure monitor. If the error persists, there 
may be an air leak and repair is necessary. 

E06 
Pressurization is greater 
than 320 mmHg. 

Do not move and try to relax during the 
measurement. If the error persists, repair is 
necessary. 

E07 Forced stop using STOP 
key 

Do not press the STOP key unless 
necessary. 

E08、E10 
Pulse can not be 
detected. 

Do not move and try to relax during the 
measurement.  

E20 
Pulse is less than 35 
beats or more than 200 
beats per minute. 

Measure the blood pressure by other 
methods. 

E21 
Diastolic is greater than 
160 mmHg or less than 
40 mmHg. 

Measure the blood pressure by other 
methods. 

E22 
Systolic is greater than 
280 mmHg or less than 
60 mmHg. 

Measure the blood pressure by other 
methods. 

E23 

The difference between 
systolic and diastolic is 
greater than 150 mmHg 
or less than 10 mmHg.     

Measure the blood pressure by other 
methods. 

E30、E31 
Air leaks in the cuff 
assembly. 

Repair is necessary. 

E32 Clock error If the error persists, repair is necessary. 

E50 Pressure offset error Repair is necessary. 

E52 Memory error Repair is necessary. 

E53 
Defective battery contact Replace batteries correctly. If the error 

persists, repair is necessary. 

 



 

 71 

Error code Probable cause Correction 

E55、E56、E57 
Exhaust error Relax and do not move during the 

measurement. If this error occurs frequently, 
repair is necessary. 

E60 Interval setting error Enter the interval parameters correctly. 

E70、E71、E72、
E73 

RS-232C error Reconnect the communication cable. If the 
error persists, repair is necessary. 

E74 Voltage decreases during 
communication. 

Replace the batteries with new ones and 
restart communication. 

E75 Protocol error due to 
external equipment 

Reconnect the communication cable. If the 
error persists, repair is necessary. 

 

14-1-2     Guidance messages 

The table below lists the guidance messages that may appear in the Receive Data/Send Setting 

Data windows. 

 

 Messages when data is received: 

Message Correction 
Failed to initialize RS233C port 

Automatic recognition of ABPM failed. 

Failed to receive data 

Failed to read measurement settings 

Failed to read measurement data 

Failed to erase measurement data 

Failed to setup the clock 

 Confirm that the communication cable is 
connected to the blood pressure monitor. 

 Confirm that the USB driver is functioning 
correctly. 

 Disconnect all the cables. Restart Doctor 
Pro3. 

 

 Messages when data is sent: 

Message Correction 
Failed to initialize RS233C port 

Automatic recognition of ABPM failed. 

Failed to send data 

Failed to erase measurement data 

Failed to erase measurement settings 

Failed to set measurement parameters. 

Failed to setup the clock 

 Confirm that the communication cable is 
connected to the blood pressure monitor. 

 Confirm that the USB driver is functioning 
correctly. 

 Disconnect all the cables. Restart Doctor 
Pro3. 

The device connected differs from the one at 
the time of automatic recognition. 

 Use the blood pressure monitor that was 
automatically recognized. 

 Click [Cancel] or restart Doctor Pro3. 
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14-2  Default Settings 

The window below shows the default settings that have been set before shipment. 

 

    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

14-3     Disposing of the Used Product 

When disposing of or recycling this product, follow your local regulations to protect the 

environment. 
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15.  CUSTOMER SUPPORT 
 

15-1 Inquiries about the Product 

Contact the local A&D dealer you purchased the product from. 

 

15-2   Disclaimer 

A&D Company Limited makes no warranty of any kind with regard to, but not limited to, the 

implied warranties of merchantability and fitness for a particular purpose. A&D believes the 

technical information contained in this document is accurate, however, in no event will A&D be 

liable for errors contained herein. A&D is not responsible for any direct, indirect, special, 

incidental or consequential damages or losses which occur in connection with the furnishing, 

performance, or use of this product. 

 

Further, A&D Company Limited does not accept liability in any of the following circumstances: 

 

Damage caused by maintenance or repair by an unauthorized dealer. 

Damage caused by not obeying the precautions described in the instruction manual. 

Damage caused by not using the measurement conditions described in the instruction manual. 

Replacement of the accessories or consumables. 

Damage caused by using products other than those supplied by A&D. 

Damage caused by modifying or disassembling the product. 

Damage caused by the user’s mishandling. 

Damage caused by a natural disaster such as fire, earthquake, flood or a lightning strike. 
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MEMO 
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